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About The Productivity Pro®, Inc.

Laura Stack, MBA, CSP, is a personal productivity expert, author, and professional speaker
who helps busy workers Leave the Office Earlier® with Maximum Results in Minimum
Time®. She is the president of The Productivity Pro®, Inc., a time management training
firm specializing in productivity improvement in high-stress organizations. Since 1992,
Laura has presented keynotes and seminars on improving output, lowering stress, and
saving time in today’s workplaces. She is one of a handful of professional speakers whose
business focuses solely on time management and productivity topics. She is a high-energy,
high-content speaker, who educates, entertains, and motivates professionals to improve
workplace productivity.

Laura is the author or co-author of five books, including The Exhaustion Cure (Broadway
Books, 2008), Find More Time (Broadway Books, 2006), two of the popular Chicken Soup for
the Soul books, and the bestselling Leave the Office Earlier (Broadway Books, 2004), which
was hailed as “the best of the bunch” by the New York Times and listed on the June 2004
Book Sense Business & Economics Bestseller list. Leave the Office Earlier has been published
in seven countries and in five foreign languages, including Japanese, Korean, Chinese,
Taiwanese, and Italian. Laura’s popular monthly electronic newsletter has subscribers in 38
countries. She is a Certified Specialist in Microsoft® Office Outlook.

Widely regarded as one of the leading experts in the field of employee productivity and
workplace issues, she has been featured nationally on the CBS Early Show, CNN, NPR,
Bloomberg, NBC TV, WB News, the New York Times, USA Today, The Wall Street Journal,
the WashingtonPost.com, the Chicago Tribune, O Magazine, SELF, Me, Working Mother
magazine, Entrepreneur magazine, Readers Digest, Woman’s Day, and Parents magazine.
Laura has been a spokesperson for Microsoft, 3M, and Day-Timers, and she is the creator of
The Productivity Pro® line of Day-Timer® planning system. Her client list includes top
Fortune 500 companies, including Microsoft, IBM, GM, Coors, the Denver Broncos,
Lockheed Martin, Lucent Technologies, Wells Fargo, Mobil, Time Warner, and VISA, plus a
multitude of associations and governmental agencies.

Laura holds an MBA in Organizational Management
(University of Colorado, 1991), integrating the importance of
productivity in business with employee retention and
satisfaction. She is on the Board of Directors of the National
Speakers Association (NSA) and is the recipient of the
Certified Speaking Professional (CSP) designation, NSA’s
highest earned designation.

Laura lives with her husband and three children in Denver,
Colorado.
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Setting Up Tasks

A task is a personal or work-related action item that you want to track until it's
completed. A task can occur once or repeatedly. A recurring task can repeat at regular
intervals or repeat based on the date you mark the task complete. For example, you
might want to send a status report to your manager on the last Friday of every month,
or get a haircut when one month has passed since your last haircut.

A. Filter The View In Your Calendar To Display The TaskPad (To-Do
List).

1. Go to the Calendar. Make sure your | [55 5% 5 s
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Task Pad is showing on the right. If
it’s not, go to the View menu and
select Task Pad.

2. Go to the View menu again and
click Task Pad View.

3. Select Active Tasks for Selected
Days. The task pad will now only
display tasks with a Start Date of
today or earlier.

B. Filter the View on the Task Pad Frm !
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1. Right-click in the TaskPad.

2. Select Task Pad Settings, then Show Fields.
3. Add and remove fields until only Icon, Complete, and Subject are showing (in

that order).
Show Fields x|
Masirnurn number of lines in rulti-ine made: 2
Select available fields From:
Frequently-used fislds j
Ayvailable fields: Show these fields in this order:
%o Complete - add - Icon =
Actual Work Complete
Attachment Subject
Cakeqories
Cormpany
Contacks
Date Completed
Due Date
Modified
Maotes
CQrganizer
Owner
Priority
Recipient Mame j J
Ok | Cancel |
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1. Right click on the word TaskPad in the Task Pad (make sure you click the
header, not inside the task pad.

| TaskPad

2. Select Customize Current View.

3. In the Customize View: dialog box, click on the Filter button.

4. Click the Advanced tab.

5. Click on the Field button on the left side in the middle of the box.

6. Click Frequently-used fields.

7. Click Complete. The default Condition and Value will automatically be filled in
with Complete, Equals, and No, which you want to keep.

8. Click the Add to List button.

9. Click OK to return to the View Summary Box.

| FIPE I RS I S R T ) FRT RV PR

x|
kPad
Cescription
Fields. .. ‘ Icon, Complete, Subject
x|
Group By... ‘ MNone I
— Tasks | More Choices Advanced |sqL |
wekp
— Sart... ‘ Subject {ascending) Find items that match these criteria:
Complete eguals Mo
—_— Filter ... ‘ Tasks: Advanced
Other Settings. .. ‘ Faonts and other Table View setting
Remove
Aukomatic Formatking. .. ‘ User defined fonts on each messa;  Define more criteria:
Figld
Format Columns. .. ‘ Specify the display formats For eac | | J |
[o]8 | Cancel | Clear All ‘

10. Click OK again.
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'. g eate a New Task.

AN

8.

On the File menu, point to New, and then click Task.

In the Subject box, type a task name.

Fill in the Start Date for the date you want the task to show up on your TaskPad.
Fill in the Due Date as applicable or different.

If you leave the Start Date and Due Date blank, it will still be in your Tasks list as
a master task list item.

Complete any other boxes on the Task and Details tabs for information you
want to record for the task.

To make the task recur, click Recurrence, click the frequency (Daily, Weekly,
Monthly, Yearly).

Click OK, and then click Save and Close.

E. Capture an Email as a Task on the Task Pad.

1.
2.

3.
4.

Right mouse click the email (or if you're viewing the email, select File).
Select “Move to Folder” from the short cut menu (or File menu).

& 1nbox - Microsaft Gutlook

DBe Edt Wew Go Tws Adiors Heb  AdobofOF

igiew = | (g M XK | CpReer (Reohto Al (4 Forerd | o SerdRegeive « | (5 | ks [l 58 B G Ostete A5 Spom Spambares - Eé&mm‘ Regon I

RE: FID RSM Meeting - § 71 Dekie on
Gresley, Knshn [knstin gre| <3| BeetoFoder..  basment com)

To: Limstwprichativtygro. com 2] Outien...
Li: Chang, America J; Marrer, Jerriler 7

Graad)
Cauld you sleo ce: Amarics J Chano £0b.cacn

Iwill be 0wt of the office next week

— -
4 start e 051201 Cobmbia ... Bt - Mcrosoft O, & % e

Select Tasks from the list.
Click OK.
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[ Inbox - Microsoft Outlook

Pple Edt view Go Iools Actions Help  Adobe FDF Type a question for help |+

diew - | 23 X | CdReply SdReply to Al b5 Forward | L sendfReceive ~ | (5 | @) 15 B ¢ (GDelete As Spam SpamBayes ~ ! : & snaglt [2f' | Region !

Folder List Inbox =
&l Falders + [ @ From Subject Received k4
2 95 Personal Folders (3 MarkBuzan Elance project Fri 11/25/2005 4:..,
1 @Tickler - fGresley, Kristin RE: FID RSM Meeting - Speaker Confirmation Fri 11§25/20057:..,
(4] Calendar
8] Contacts
(4] Deleted Items
L7 Drafts =
[ 3 1nbox Move ltems X
& ournal —
23 Junk emai Mo the selected ikems to the Folder:
[ unk E-mail T Calendar B8
oK
2 s o o -
@ 3 Laura's folders 5] Delsted Items
Hates (7 Drafts
(31 utbox (3 Tmbox Mew,
[ sent rems I Journal
Tasks 3 Junk email
# [ Search Folders [ JurkE-mail
older 3 Junk suspects
older Sizes i (3 Laura's folders
Data Flle Management... RE: FID RSM Mee ] Hotes
Greeley, Kristin [kri (= utbox
To: Laura@theproductivity |
o Chang, America J; Ma ~
~
Great!
Could you also cc: Armetica.. Changi@columbiamanagement. com =
lwill be out of the ofice next week
Kiistin Greeley
Columbia Management Distributors, Inc
One Financial Center, MAS-515-14-05
Bostan, MA 02111
B17-772-3405
» Faw: B17-772-3533 ]
2 Items

This will activate a task properties window.
Update all of the information accordingly. Use the “Start Date” to indicate when

you want the task to appear on your Task Pad. You can set a reminder here or
even type notes to yourself.

Click the “Save and Close” button.

El RE: FID RSM Meeting - Speaker Confirmation - Task

i File Edt View Insert Format Teols  Actions Help
: 7 - LALBLILE
l

i dlsaveandCiose | L 4 % (] | AT¥Recurence..

ZAhssin Task | Ay o | X | o - ;~|@

Task | Detals |

Subect: | Create Columbia Managemert workbock

Due date: Hone v status; |Mot Scarted v/

Stat dake:  |Mone | Priorty: [Mormal | % Complete: [0% | %

[Creminder: | il | Owner: [ aura Stack - The Productivity Pra(R)

RE: FID RSM
Aeeting - Speaker ..

[cortaets | |

| [(categories... ] | | erivate [

& B x> a44rm
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Educational Resources by Laura Stack

Virtual Outlook series via Webinar/Online training:
http:/ /www.theproductivitypro.com/s outlook-virtual-training.html

Productivity webinar series: http:/ /www.theproductivitypro.com/s_virtual-
webinar.htm

Hire Laura to speak at your next conference, meeting, or event:
http:/ /www.theproductivitypro.com/s seminars_and workshops.htm

Join Laura’s private LinkedIn network, The Productivity Pro® Alumni, to exchange
ideas and insights: http:/ /www.linkedin.com/e/vgh/1259217/

Follow me on Twitter: http:/ /twitter.com/laurastack

Sign up for my free monthly newsletter, The Productivity Pro®:
http:/ /www.theproductivitypro.com/r subscribe.htm

Subscribe to my blog: http:/ /www.theproductivitypro.com/blog/

Laura’s website has over 100 free articles for download:
http:/ /www.theproductivitypro.com/Featured Articles/article map.php

FREE downloadable worksheets, checklists, and resources:
http:/ /www.theproductivitypro.com/r free stuff.htm

Take the quizzes FREE from Laura’s three books:
http:/ /www.theproductivitypro.com/r quizzes.htm

Get a FREE tip of the day via email:
http:/ /www.theproductivitypro.com/r subscribe 365Tips.htm

Receive a tip each week texted straight to your cell phone:
http:/ /www.theproductivitypro.com/r-TipOfTheWeek.htm

Educational Resources for purchase (books, CDs, DVDs, self-study audio, video
training, MP3s etc.) http:/ /www.theproductivitypro.com/t_productivity_tools.htm

Buy the Productivity Pro® Day-Timer: www.daytimer.com/laurastack

Laura’s YouTube channel: http:/ /www.youtube.com/user/theproductivitypro
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The Productivity Pro® Laura Stack and Day-Timers introduce...

The Productivity Pro Planner!

The efficiency of electronics integrated with the reliability of paper...

Hand-helds are great task managers, but they're not configured for extensive
note-taking. Professional speaker, Laura Stack, has designed the first planner
geared specifically to hand-held users. 2-Page-Per-Day pages, each with a
productivity tip. Pages have no time slots or calendars, o their writing space is
larger and more efficient. Neutral colors on daily pages and monthly tabs rotate

Phena Calls
section tracks
and records
phona activity

Errands section
helps you keep

track of those
“must do” tasks

by quarter. Monthly Tabs have ample space for planning appointments and
meetings, with space to list monthly goals and to-dos. A-Z Tabs do double duty
as a contact management system and a paper filing system. Use matching Note
Pages to caplure notes, create lists, and track projects, and then file them behind
the appropriate alpha tab. Colored dots code your calendar by priority or activity.

To-Do List
records activities

Capture and coordinate commitments
on the monthly tabs. Track meetings,
appointments, and obligations that
must occur at spacific times. Then, use
the selt-stick dots to code priority.

Laura Stack

6 THURSDAY THURSDAY 6
NOVEMBER 2008 NOVEMBER 2008
L hHonecAus | |- _____________roooust |

Dty Ortran - Bank of Anerica O (@) Register CHCC event Sept 3. e
Book Tamga FL ticket Aug 5 trip
Wam - visit August? Invoice Encana June 2B saminar
Qo Virike Jily pewsietzer
Nancy Manu_]c._Tary_‘- schedils Send participant workkook Famy
committee cont, cal
L Tnvite panelists for convention
- (@] Q Create PowerPant. shiow for SUnoco seminar
Dantist - sched, & month checkup i . ;
mail Lip sheets 1o Jannifer
Post bloa entry
Sally Meinee - building ops -
need exten S-Foot table
L Eeeanos | =
Great indoors faucet O O . -
8 Macy's suitcase ——
Walareen's Fx_ - H !
ol|loe =
2-Page-Per-Da " " .
9 Y 33%" x 6%" Page Size

The Productivity Pro®

MNote Pages

Qe

8 l

A-Z/Filing Tabs

TheProductivityPro.com

2-Page-Per-Month

Dots (4 sheets)

For more details and to order, visit daytimer.com/productivity
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